BW Report Center
vs.
Analysis
# Table of Contents

Select a topic below to go to that topic page.

## Variable Screen

- Variable Screen - *Mandatory Variables* ................................................................. 5
- Variable Screen - Wildcards and Ranges .................................................................. 5
- Variable Screen - Range Selection ......................................................................... 5
- Variable Screen - Member Selector (Filtering) ....................................................... 6
- Variable Screen - Dates .......................................................................................... 7
- Variable Screen - Prompt Summary ......................................................................... 7
- Variable Screen - Inserting Rows ........................................................................... 7
- Variable Screen - Excluding Rows .......................................................................... 8
- Variable Screen - Check and Execute ....................................................................... 8
- Variable Screen - Error Messages ........................................................................... 9
- Variable Screen - Bring Up the Variable Screen from a Query .............................. 9

## Navigation ............................................................................................................. 10

- Navigation - Search for Reports or Folders ......................................................... 10
- Navigation - Toggle Nav Block and Layout Panel .................................................. 11
- Navigation - Resizing Columns and Rows ............................................................. 11
- Navigation - Scrolling through Rows of Data ....................................................... 12
- Navigation - Go To Function (Drilldown into Related Reports)............................. 12
- Navigation - Deselecting Cells in the Results Panel ............................................ 13
- Navigation - Search Using Ctrl+F to Find Granular Data within Report ............. 13
- Navigation - Open More Than One Report at One Time ....................................... 14
- Navigation - Stopping a Long Run Time ............................................................... 14
Customizing

Query – Add Free Characteristics ................................................................. 14
Query – Remove Characteristics ................................................................. 15
Query – Add Attributes ............................................................................... 16
Query – Characteristic Display ................................................................. 17
Query – Show Repeated Texts ................................................................. 17
Query – Swap Characteristics ................................................................. 18
Query – Sort ............................................................................................... 18
Filter – With Text Search .......................................................................... 19
Filter – Fix Filter Value to Axis ................................................................. 20
Filter – Keep Filter Value ........................................................................ 20
Filter – Removing Key Figures ................................................................. 21
Filter – Remove Filter ............................................................................. 21
Query – Totals (Show All Results or Suppress All Results) ......................... 22
Query – Undo .......................................................................................... 23
Queries – Undo all ................................................................................... 24

Saving/Organizing/Sharing ........................................................................... 25

Copy Data .................................................................................................. 25
Exporting Data – to Excel .......................................................................... 26
Exporting Data – to Excel with Repeated Texts ........................................... 26
Exporting Data – Naming Files ................................................................. 26
Printing ...................................................................................................... 27
Bookmarks ............................................................................................... 28
Bookmarks – Creating Folders in Your Favorites Folder ................................ 29
Email ........................................................................................................ 30
Advanced Customizing..............................................................................................................31

Conditions – Query-defined (BEx Conditions) ...........................................................................31
Filter – Characteristic Not Displayed on Report ......................................................................... Error! Bookmark not defined.

Conditions – Custom Conditions ............................................................................................... 32
Conditions/Exceptions – Highlighting Specific Values or Ranges of Data ..................................... 33
Exceptions ................................................................................................................................ 34

Conditions – Deleting a Condition ............................................................................................. 35
Conditions – Undoing .................................................................................................................. 35

Hierarchy – Add/Change a Predefined JHU/JHHS Hierarchy ....................................................... 36
Hierarchy – Remove a Predefined Hierarchy .............................................................................. 37

Hierarchy – Add a Display Hierarchy to Help Organize and Compact Data .................................. 38
Hierarchy – Remove a Display Hierarchy ................................................................................... 39

Filter – Characteristic Not Displayed on Report ...................................................................... 39

Format Key Figures – Change Decimal Points, Use Thousands Separator ................................... 40

Query – Totals Display on the Top or the Bottom ...................................................................... 41

Query – Swap Axes ....................................................................................................................... 41

Query Layout – Properties Tab ................................................................................................... 42
**Variable Screen**

<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Variable Screen – <strong>Mandatory Variables</strong></td>
<td></td>
</tr>
<tr>
<td>Required selection variables are denoted by an asterisk.</td>
<td>Mandatory selection variables are denoted by a red asterisk in the righthand prompt area.</td>
</tr>
</tbody>
</table>

- **Personnel Area (UN* and/or HS*) (*)**
- **Key Date (*)**

<table>
<thead>
<tr>
<th>Prompt Summary</th>
<th>All</th>
<th>Required</th>
<th>Optional</th>
</tr>
</thead>
<tbody>
<tr>
<td>* Personnel Area (Selection Option, Required)</td>
<td>Include</td>
<td>values</td>
<td></td>
</tr>
<tr>
<td>* Organizational Unit (Selection Option, Required)</td>
<td>Include</td>
<td>values</td>
<td></td>
</tr>
</tbody>
</table>

**Variable Screen – Wildcards**

Wildcard characters are valid options for a variable value, i.e., 170*.

- **Non Sponsored Financial Summary**
- **Period/Fiscal Year (Single Value Entry, Required) (*) 2015**
- **Funds Center (Selection Option, Optional) 170**

To use an asterisk (*) you must select the **Equal** function with numeric values only (letter values will not work), multiple lines are okay as displayed below.

- **Funds Center (Selection Option, Optional)**
  - Include | values | Equal | 17010* | **X** |
  - Include | values | Equal | 115000* | **X** |

**Variable Screen – Range Selection**

To change between a single value or range, change the equals sign to a symbol for [ ] or >, etc.

Variables allowing multiple values will default to **Between** (range).

- **Funds Center (Selection Option, Optional)**
  - Include | values | Between | 1700000000 and 1799999999.
Variable Screen – Member Selector (Filtering)

Searches for various text fields such as PI names, shopping cart requestors, etc. are case sensitive.

1. Text searches area is case sensitive.
2. Make sure the Find field data matches the type: either Key or Text. Default in BW is Text.
3. Click the Find button.
4. Once the data is displayed, check off entry or entries.
5. Click the Transfer button to apply the filter.

Member selection field can be displayed in a variety of ways other than the default of Key: Text. Text-only fields are case sensitive.

1. Type the search term, i.e., Lastname*FirstInitial*. You may replace spaces in the search field with asterisks and likewise, use asterisks to complete names.
2. Click the Binoculars dropdown to match the data with the type, either Key or Text. Default in Analysis is Key.
3. Click Find members “Binoculars” button to launch search.
4. When results appear, highlight the appropriate value.
5. Click the OK button to apply the filter.
### Variable Screen – Dates

Dates are entered in standard format mm/dd/yyyy or fiscal year format, 01/15, for the first period of the fiscal year 2015.

Dates must be entered as YYYYMMDD or chosen from the selection box. Dates for fiscal year periods are added the same way as BW, i.e., FP/FY.

### Variable Screen – Prompt Summary

Variable screens with no data are empty. Text shows for completed variables. An asterisk means a variable is required. Click Check and then Execute to run report.

Green checks in the Prompt Summary area show that these fields contain data. A red asterisk means that the value is mandatory and OK button will not activate until mandatory fields contain data.

The OK button at the bottom of the Prompt Summary screen will not activate until all the mandatory fields contain data. Make sure you hit Enter to after adding new or corrected mandatory data.

### Variable Screen – Inserting Rows

To add extra variables, click the Insert Row button.

To insert rows and to add more variables to the Prompt screen, click the plus sign button.
### BW Report Center

#### Variable Screen – Excluding Rows

To exclude certain variables from a report for a particular run, select **Exclude** from the **Include** dropdown box.

![Exclude from Include dropdown box](image1)

To exclude certain variables from a report for a particular run, select **Exclude** from the **Include** dropdown box.

![Exclude from Include dropdown box](image2)

#### Variable Screen – Check and Execute

Click **Execute** at any time and a message will appear if all required (*) variables are not filled in.

You must hit the **Enter** key on your keyboard after filling in all mandatory variables in order for the **OK** button to be enabled.

![Prompt Summary](image3)
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Variable Screen – Error Messages</strong></td>
<td>Errors on the variable screen will be designated by a red icon next to the variables. Hover over the X to view a tool tip of the error message.</td>
</tr>
</tbody>
</table>

![Error Message Example](image1)

If incorrect values are entered into the Prompts screen and you are able to click the OK button, an error message will pop-up.

![Error Message Example](image2)

<table>
<thead>
<tr>
<th><strong>Variable Screen – Bring Up the Variable Screen from a Query</strong></th>
<th>To bring up the variable screen from within the query results, click the <strong>Variable Screen</strong> button.</th>
</tr>
</thead>
</table>

![Variable Screen](image3)

To bring up the variable screen from within the query results, click the **Prompts** button.

![Prompts Button](image4)

**NOTE:** If the Data Panel is hidden, click the **Data** (blue cube) icon.
Navigation

<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Navigation – Search for Reports or Folders</strong></td>
<td>There are three ways to search:</td>
</tr>
</tbody>
</table>
| Type the report name or partial name into the search box at the bottom of the Role Menu tab on the report center and click **Search** button. | 1. From **Documents** tab in Launchpad  
   a. Click the **Search** tab.  
   b. Type the report name or partial name. Do not use wildcards (*).  
   c. Click the 📜 search icon. |
| In the BW report you can click Ctrl+F to find granular data within the report. | 2. From the right-hand corner of the Launchpad  
   ![Search bar in Launchpad](image)  
   Typing here starts a visible search in the dropdown below. |
| | 3. In your **My Favorites** folder  
   a. Hover over the right-hand side of the **Title** header so the filter icon appears and then left-click the filter icon.  
   b. Type a search term in the pop-up.  
   c. Click **OK.** |

Continued on next page.
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Navigation – Toggle Nav Block and Layout Panel</strong></td>
<td>To bring up the columns and rows, click the <strong>Layout Panel</strong> icon.</td>
</tr>
<tr>
<td>Use the <strong>Toggle Nav Block</strong> to view query selections.</td>
<td></td>
</tr>
</tbody>
</table>

| **Navigation – Resizing Columns and Rows** |  |
| Columns and rows cannot be resized. | Resize columns by clicking on the dividing line to the right of the column header and dragging the column divider. Resize the pane between characteristics and key figures by dragging the pane divider within the data portion of the query. Drag to the left to show more numbers, and drag to the right to show more members. |
### BW Report Center

#### Navigation - Scrolling through Rows of Data

Click the **No. of Rows** button to change the number of rows showed on the screen and click the arrows to scroll up or down through the pages.

![No. of Rows button](image)

Use the toolbar on the right to scroll down through the rows. Data is not separated into pages.

#### Navigation - Go To Function (Drilldown into Related Reports)

Right-click on the value and scroll to **Go To** ➔ appropriate link to view the related report.

![Go To function](image)

Right-click on the value and scroll to **Go To** ➔ appropriate link to view the related report.

![SRM Purchase Order](image)
**BW Report Center**

**Navigation – Deselecting Cells in the Results Panel**

This is not available in BW.

**Analysis**

There are two ways to deselect areas of the Results Panel.

1. **Ctrl+left-click** in the selected cell.
2. Click in the blank space under the Report Name in the Results panel. In this area, you can also launch Ctrl+F for granular searches.

**Navigation – Search Using Ctrl+F to Find Granular Data within Report**

Click anywhere in the report and type **Ctrl+F** to find granular data within the report. The **Previous** and **Next** buttons tab the cursor from one data hit to the next.

1. **Place your cursor in the blank area between the name of the report, above the row heading.**
2. **Type Ctrl+F** to get granular searches of your data.
3. **Type search term in Find Field and hit “Enter”**.
4. **Scroll to find highlighted entries.**

**NOTE:** The **Previous** and **Next** buttons in the Ctrl+F function do not work in Analysis. You need to scroll to find the highlighted text.
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Navigation – Open More Than One Report at One Time</strong> Click the New Window button to view multiple reports in different windows.</td>
<td>Each report automatically opens in its own tab in Launchpad.</td>
</tr>
</tbody>
</table>

![BW Report Center](image)

<table>
<thead>
<tr>
<th>Navigation – Stopping a Long Run Time Close your browser.</th>
<th>To stop a long processing time, log off or close your browser.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>NOTE:</strong> The query will still be running in the background.</td>
<td><strong>NOTE:</strong> The query will still be running in the background.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Customizing</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Customizing</strong></th>
</tr>
</thead>
</table>

| **Query – Add Free Characteristics** Click the **Add drilldown** icon next to the characteristic in the Navigation block. | Find the characteristic under the **Data** panel. Drag it onto the report in the desired location or into the Rows panel in the desired location. |

![Query - Add Free Characteristics](image)

**Drag and drop between Data and Layout panels**
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query – Remove Characteristics</strong></td>
<td>Grab the characteristic or attribute from the report or from the Rows panel and drag it back into the Data panel.</td>
</tr>
<tr>
<td>Click the <strong>Remove drilldown</strong> icon next to the characteristic in the Navigation block.</td>
<td><img src="image" alt="Diagram showing drag and drop between Data and Layout panels" /></td>
</tr>
</tbody>
</table>
Query – Add Attributes

Right-click on a characteristic and choose Properties from the dropdown. Check the attributes to display. Use the numbered field (far righthand side) to order the display of the attributes. Press the Transfer button to apply them.

1. Find the characteristic in the Data panel.
2. Expand the plus sign (+) next to it.
3. Expand the plus sign next to Attributes.
4. Drag the desired characteristic(s) onto the report or into the Layout panel.
<table>
<thead>
<tr>
<th>Query – Characteristic Display</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click a characteristic and choose <strong>Properties.</strong> Choose <strong>Key,</strong> <strong>Text</strong> or another option.</td>
<td>Right-click the characteristics’ header. Choose <strong>Display as</strong> and then the desired format.</td>
</tr>
</tbody>
</table>

**NOTE:** *Options Key: Medium description or Medium description are recommended with personal names and vendor names.*

---

<table>
<thead>
<tr>
<th>Query – Show Repeated Texts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click anywhere in the query and choose <strong>Show Repeated Texts.</strong></td>
<td>It is not possible to set repeated texts in the query view. When you export to Excel, select <strong>Repeat outer header members</strong> and <strong>Export Key and Text values as separate columns.</strong> You may have to scroll to get to the check boxes shown in 1 and 2 below. Click OK.</td>
</tr>
</tbody>
</table>

**NOTE:** *Hovering the cursor over the column or area will reveal the data in that column for that row.*
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query – Swap Characteristics</strong></td>
<td>Same as BW (on left). In Analysis you can drop and drag characteristic(s) to new locations in the Layout panel.</td>
</tr>
<tr>
<td>Right-click the characteristic and choose <strong>Swap (Old Characteristic)</strong> with <strong>(New Characteristic)</strong>. Characteristics will vary dependant on what you would like to swap.</td>
<td></td>
</tr>
</tbody>
</table>

| **Query – Sort** | Right-click the Characteristic **header** and choose **Sort**. Pick the sort characteristic and direction. |
| Right-click on the characteristic and choose **Sort**. Then choose the sort option. |  |

**NOTE:** Some objects may have a different default sort order in Analysis than was seen in BW.
**Filter – With Text Search**

Click the filter icon next to the characteristic in the Navigation block.
1. Type the case-sensitive name or portion of the name in the text field
2. Select **Search in Text**, if appropriate.
3. Click the **Find** button,
4. When the results appear, check off the names, and
5. Click the **Transfer** button.

<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong> Right-click the Characteristic header and choose <strong>Filter</strong></td>
<td><strong>1.</strong> Right-click the Characteristic header and choose <strong>Filter</strong></td>
</tr>
<tr>
<td><strong>2.</strong> Select <strong>By member...</strong></td>
<td><strong>2.</strong> Select <strong>By member...</strong></td>
</tr>
<tr>
<td><strong>3.</strong> Complete the member selector options. Text fields are case sensitive. Replace spaces in search field with asterisks and use asterisks to complete names.</td>
<td><strong>3.</strong> Complete the member selector options. Text fields are case sensitive. Replace spaces in search field with asterisks and use asterisks to complete names.</td>
</tr>
<tr>
<td><strong>4.</strong> Click <strong>Find Members</strong> binoculars <strong>dropdown</strong> to match the data with the type, either Key or Text.</td>
<td><strong>4.</strong> Click <strong>Find Members</strong> binoculars <strong>dropdown</strong> to match the data with the type, either <strong>Key</strong> or <strong>Text.</strong> Default in Analysis is <strong>Key</strong>.</td>
</tr>
</tbody>
</table>

**Search Results Shown Below**

5 Click to highlight appropriate value. **NOTE:** Multiple value selection is not possible. You will have to repeat these steps and select one new member and **OK** to transfer each variable to your prompt screen.
<table>
<thead>
<tr>
<th>Filter - Fix Filter Value to Axis</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click in the value you want to keep and select <strong>Fix Filter Value to Axis</strong>.</td>
<td>Left-click to select one Key Figure. Right-click to get the menu selection and select <strong>Keep Members</strong>.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Filter - Keep Filter Value</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click in the value you want to keep and select <strong>Keep Filter Value</strong>.</td>
<td>Left-click to select one Key Figure. Right-click to get the menu selection and select <strong>Keep Members</strong>.</td>
</tr>
</tbody>
</table>

**NOTE:** To select multiple individual members in reports that have no added filters to the left of the data being selected, hold down the Ctrl key while selecting members. Likewise, to select a range of members, select one end point of the range, hold down the Shift key, and then select the second end point. **NOTE:** The **field will stay in the results area. Drag to the Background filter area to no longer display on the report.**
**BW Report Center**

**Filter – Removing Key Figures**

To remove a key figure column or a row with sensitive information, right-click to pull up Context Menu and choose **Select Filter Value**. Uncheck the key figure and click the **Transfer** button to apply the changes.

<table>
<thead>
<tr>
<th>Date</th>
<th>Pay Period</th>
<th>Salary Amt</th>
<th>Fringe</th>
<th>Commitments</th>
</tr>
</thead>
<tbody>
<tr>
<td>09/30/2013</td>
<td>$710.43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>09/30/2013</td>
<td>$710.43</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12/31/2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12/31/2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12/31/2013</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Analysis**

To remove a key figure column or a row with sensitive information, do the following:

1. Right-click key figures header.
2. Go to **Filter** and then **Filter by member**...
3. Select members to remove.
4. Click **OK**.

![Filter and then By member...]

**Right-click key figures header**

**Check or uncheck to select or deselect.**

**Filter and then By member...**

**Maximum Number of Hits**

1. 200

---

**Display**

- **Select Filter**
- **OK**
- **Cancel**

**Select Members**

- 001/2015
- 002/2015
- 003/2015
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter - Remove Filter</strong></td>
<td>Right-click the characteristic header and choose <strong>Filter  \rightarrow</strong> by member. Choose Select Everything and click OK.</td>
</tr>
<tr>
<td>Click the remove filter icon (trash can) next to the characteristic filter in the Navigation block.</td>
<td>![Diagram of filter interface]</td>
</tr>
</tbody>
</table>
Query – Totals (Show All Results or Suppress All Results)

Totals and subtotals are added and removed by right-clicking on a characteristic and going to Properties. Choose the appropriate option for Suppressing Results Rows.

Right click in the header characteristic and select an option to either Show totals or Hide totals.

NOTE: There is no one button to Suppress All Results in Analysis.

Work-around: Left-click item in report or ctrl+left-click to select multiple items. Once the items are selected, then do the following:

1. Right-click in the values field and then select Totals.
2. Select Calculate total as option.
3. Select Sum to show results or Hide to suppress results.
<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Query - Undo</strong></td>
<td></td>
</tr>
<tr>
<td>Right-click in the report results. Select <strong>Back</strong> to undo one step.</td>
<td>Click the <strong>Undo</strong> button on the toolbar as many times as needed.</td>
</tr>
<tr>
<td><img src="image1" alt="Back" /> <img src="image2" alt="Back to Start" /> <img src="image3" alt="Keep Filter Value" /> <img src="image4" alt="Fix Filter Value to Axis" /> <img src="image5" alt="Select Filter Value" /> <img src="image6" alt="Filter Value" /></td>
<td><img src="image7" alt="Undo" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Queries - Undo all</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Right-click in the report results, select <strong>Back to Start</strong> to undo everything since the report was run.</td>
<td>Click the <strong>Discard all Changes to this Workspace</strong> button to go all the way back to the beginning, including bringing up the variable screen again with default values.</td>
</tr>
<tr>
<td><img src="image1" alt="Back" /> <img src="image2" alt="Back to Start" /> <img src="image3" alt="Keep Filter Value" /> <img src="image4" alt="Fix Filter Value to Axis" /> <img src="image5" alt="Select Filter Value" /> <img src="image6" alt="Filter Value" /></td>
<td><img src="image8" alt="Discard all Changes to this Workspace" /></td>
</tr>
</tbody>
</table>
### Saving/Organizing/Sharing

**BW Report Center**

**Copy Data**

Highlight the desired data and hit Ctrl+C. Paste into another application.

| JHEN832400 | SRV CTR-SERVICES | $34.85 |
| JHEN832400 | SRV CTR-SERVICES | $76.00 |
| JHEN832400 | SRV CTR-SERVICES | $37.25 |
| JHEN832400 | SRV CTR-SERVICES | $40.50 |
| JHEN832400 | SRV CTR-SERVICES | $2,714.23 |

**Analysis**

Copy function is not available. Use the export function instead.

1. To select one cell, (i.e., document number to research), right-click single value, or Ctrl+left-click to select several values.
2. Right-click to get to the selection menu.
3. Scroll to select **Keep Members**.
4. Export this subset to Excel.

---

1. **Right-click** single value, or Ctrl+left-click to select several values.
2. **Right-click** to get dropdown
3. **Keep Members**
4. Export to Excel
### Exporting Data – to Excel

Click the **Printing** button and select **Print to Excel**.

There are several options for exporting: Excel, CSV and Adobe PDF. Select the option from the **Export data to Excel** icon.

### Exporting Data – to Excel with Repeated Texts

Right-click anywhere in the query and select **Show Repeated Texts**.

When you export to Excel, you may have to scroll to get to the check boxes shown in 1 and 2 below.

1. Select **Repeat outer header members**.
2. Select **Export Key and Text values as separate columns**.
3. Click **OK**.

### Exporting Data – Naming Files

Naming convention is not intuitive.

File names are automatically derived from report name and include run date and run time.

<table>
<thead>
<tr>
<th>File name</th>
<th>Save as type</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAPYTDTS2H74QL832ULINIFEXCEL.xls</td>
<td>Microsoft Excel 97-2003 Worksheet</td>
</tr>
<tr>
<td>BW Report Center</td>
<td>Analysis</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td></td>
</tr>
</tbody>
</table>
| Click the **Printing** button and select the paper type and layout. | 1. Click the **Print to PDF** icon.  
2. Be sure to select the option to print **Data**.  
3. You can then select your paper size and headers/footers as well.  
4. Click OK.  |

![Diagram of printing options]

**Optional:** Add a header or footer to your report.
Click the **Bookmark** button. Name the bookmark and click **Save**.

**Bookmarks**

<table>
<thead>
<tr>
<th>Add Favorite</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Choose Folder</strong></td>
</tr>
</tbody>
</table>

**My Favorites**

- Budget

Favorite will be saved to **My Favorites**

**Favorite Name**

**Save**

---

Click the **Save As** button and name your file. It will be saved alphabetically in your **Favorites** folder.

1. [Save]
2. [Save As...]
3. **File Name**

**Save As Type**

- Analysis Workspace

**Description**

Optional: By expanding the arrows you may include description here.

**NOTE:** The workspace will automatically save your unsaved work to your `/Document/Favorites` every 15 minutes.
**Bookmarks – Creating Folders in Your Favorites Folder**

A bookmarked report will automatically save to your *My Favorites* folder unless you create a new subfolder for it. After clicking the *Bookmark* button, follow the pop-ups to create a folder to house your new report.

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Choose folder and select a location.</td>
</tr>
<tr>
<td>2.</td>
<td>Enter a new folder name.</td>
</tr>
<tr>
<td>3.</td>
<td>Click <em>Save</em> to save the folder.</td>
</tr>
<tr>
<td>4.</td>
<td>Edit the favorite name if necessary.</td>
</tr>
<tr>
<td>5.</td>
<td>Save the favorite to <em>My Favorites</em>.</td>
</tr>
<tr>
<td>6.</td>
<td>Click <em>Save</em> to save the report.</td>
</tr>
<tr>
<td>7.</td>
<td>Close the pop-ups.</td>
</tr>
</tbody>
</table>

**Analysis**

To organize your work, you may want to create subfolders within your *My Favorites* folder. *NOTE:* The workspace will automatically save your unsaved work to your */Documents/My Documents/My Favorites* every 15 minutes.

1. Save → Save as.
2. Click the folder icon.
3. Type the new folder name.
4. Click OK.
5. Click the new folder to open it once it shows up under the *Favorites* folder.
6. Type the new File name.
7. Click Save.

---

**Diagram:**

- Save → Save as
- Click the folder icon
- Type the new folder name
- Click OK
- Click the new folder
- Type the new File name
- Click Save
BW Report Center

Analysis

Email

Click the Email button.

You can only email a saved file.
1. Click the Envelope icon drop down.
2. Choose the SAP BusinessObjects Inbox.
3. In the pop-up, the fastest (and recommended) method is to use the JHED ID in the Find Title field (Find Title is the default.) You may use partial JHEDs, but not the wildcard.
4. Click the binoculars to launch the search that will generate a list of name(s) below the Find Title Field.
5. Select the name(s) in the lefthand column
6. Click the > button to transfer the name to the Selected Recipients column.
7. Click the Send button.

NOTE: Make sure that you select User List each time you search for a new user.

NOTE: The email will show up in the recipient’s Analysis inbox. It is recommended to send an email via Outlook or another method to let them know the report was mailed to their Analysis inbox.
### Advanced Customizing

<table>
<thead>
<tr>
<th>BW Report Center</th>
<th>Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Conditions - Query-defined (BEx Conditions)</strong></td>
<td>Right-click the characteristic HEADER and choose <strong>Filter</strong> → <strong>BEx Conditions</strong> and clicking on or off the Condition.</td>
</tr>
</tbody>
</table>

Click the **Exceptions / Conditions** button. Activate or Deactivate existing conditions by clicking the toggle button.
**Conditions – Custom Conditions**

1. Click the **Exceptions / Conditions** button.
2. Under the conditions section, click the **Create** button.
3. Apply your threshold for the values to display.
4. Click **Transfer**.

**Evidence of condition(s)** will display above the report with the Name of the condition and the active or inactive status showing. See Below.

**Analysis**

1. Right-click the last characteristic header **all the way to the right** and choose **Filter ➔ By measure...**
2. Create the condition by choosing the key figure and range or threshold to display.
3. Click the **Add** button.
4. Click **OK**.

**Results are shown at right.**
BW Report Center

Conditions/Exceptions – Highlighting Specific Values or Ranges of Data

You can highlight ALL numerical data in one column by right-clicking a value point in the column and checking the Highlighting option. Click Transfer to apply the highlighting.

Analysis

1. From the Analyze tab, select Conditional Formatting ➔ New.
2. Complete the fields in the Conditional Formatting pop-up screen.
3. Use the Display option (under the Definition Option) to extend formatting to column or row headings.
4. Check the Preview option to preview results.
5. Click OK to apply the results.

Sample of highlighted column is shown on the right.
Exceptions

This is one way to highlight data based on value ranges. The “Good” to Bad” color values are pre-defined.

1. Click the Exceptions/Conditions button.
2. Click the Create button under Exceptions.
3. Complete the fields for the exceptions.
4. Click the Transfer button to apply the exceptions.

Resulting data shows values equal and above 200 are highlighted green (good). The name of the Exception and it’s status is listed above the query. Sample data on right shows highlights.

<table>
<thead>
<tr>
<th>Exceptions:</th>
<th>$50.19</th>
<th>$30.51</th>
</tr>
</thead>
<tbody>
<tr>
<td>Above 200</td>
<td>$332.58</td>
<td>$324.90</td>
</tr>
</tbody>
</table>

Analysis

1. From the Analyze tab, select Conditional Formatting.
2. Name your condition.
3. Define the condition(s).
4. Click Add to put them in the Rules area.
5. Check the Preview option to preview results.
6. Click OK to apply the results.

NOTE: Hovering the cursor over the conditional value in the Results panel will show the details of the formatting (shown in righthand image).
### Conditions – Deleting a Condition

Right-click the name of the Exception or Condition and select Change, Delete or Deactivate.

Right-click in a conditionally highlighted cell, and select **Conditional Formatting**. In the next dropdown select the name of the condition and then either **Edit** or **Delete**.

### Conditions – Undoing

Right-click on the condition’s name in the grey box and select Delete or Deactivate.

Right-click the characteristic header. Choose **Filter → By measure → Delete**.
**Hierarchy – Add/Change a Predefined JHU/JHHS Hierarchy**

Right-click the characteristic, choose **Query Properties**. Click the checkbox to activate hierarchy and choose the hierarchy to apply and expansion level. Click **Transfer** button to activate the hierarchy.

**Data Formatting**
- In Tabular View
- In a multi-dimensional view
- Display Rows as Hierarchy and Expand to:
- Key Figures
- Posting Date
- Key Figures
- Posting Date

**Transfer**

Note: To successfully transfer your bookmarked hierarchies to Analysis you will need to look under the properties of the characteristic. Hierarchies are not shown on the Info Tab.

Find the characteristic under the **Data** panel.
1. Expand the plus sign (+) next to it.
2. Find the desired hierarchy.
3. Drag it onto the report on top of the characteristic (or in a new column if the characteristic is not already on the report).

**Resulting Hierarchy** formats the data in a prescribed way.
Hierarchies – Remove a Predefined Hierarchy

Right-click the characteristic and in dropdown menu, select Deactivate Hierarchy.

There are at least two ways to remove a hierarchy.

1. Drop and drag the original characteristic from the Data panel back to the Layout panel to replace the hierarchy.

2. Right-click in the column header named for the hierarchy. Select Remove. You will need to add the original characteristic back into the file. For example, you would need to add the Cost Element characteristic back into the query.
Right-click in the query results and choose **Query Properties**. Check the option next to **Display Rows as Hierarchy** and **Expand** to then select the level you want using the dropdown options.

Under the **Display** tab, click the **Hierarchy** button and select an option.

Resulting data is collapsed and saves valuable report “real estate”. Click the plus sign (+) to expand and the minus (-) to collapse the data.
### BW Report Center

#### Hierarchy – Remove a Display Hierarchy

Right-click in the query results and choose **Query Properties**. Uncheck the option to **Display Rows as Hierarchy**.

In the **Display** tab, select the **Hierarchy** button, and click the checked option to deselect that hierarchy and remove its display from the Results panel.

---

#### Filter – Characteristic Not Displayed on Report

Click the filter icon next to the free characteristic. Check values and click **Transfer**.

Drag the characteristic to the **Background** area of the Layout panel.

The characteristic will show as filtered under the Free Characteristics area.

---

No-display selection goes here, in Background.
**Format Key Figures – Change Decimal Points, Use Thousands Separator**

Right-click the Key Figure, go to **Properties** and select the required format and click **Transfer**.

1. Go to the **Display** tab above the query and click the **Measure Format** button.
2. Select the measure(s) you want to format.
3. Select the type of formatting and enter the options.
4. Click the **OK** button.
### BW Report Center

#### Query – Totals Display on the Top or the Bottom

Right-click and choose **Query Properties**. Under the **Number format** section change the **Results Position** to **top/bottom/left/right**.

You can use the **Display** tab to set totals to display before (above) or after (below) the query results.

![Display tab](image)

1. **Display tab**
2. Options for positioning totals (after members vs. before members)

#### Query – Swap Axes

Right-click a characteristic and choose **Swap Axes** to pivot your table’s axes.

Click the **Swap Axes** button under the **Display** tab.

![Swap Axes button](image)
Columns and rows cannot be resized.

Row and column height can be set for each workspace. Click the **Properties** icon, set the column width and the row height in pts and click **Apply**.

**NOTE:** It will apply to ALL cells. 100pt is the default column width. 20pt is the minimum row height. You would then need to resize each individually that you want to change.